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Highlights of Changes form ESCA 200X to ESCA Hawk V1.01 
 
 
Spectrum Display Window (Graphic Viewer) 
 The Spectrum Display Window is used in both the capture and analysis programs.  
 The following additions are included: 

• Create stored preferences for appearance of spectra. 

• Individual appearance settings for 
o Graphic Viewer 
o Clipboard 
o Printing – only available in Analysis application 

• Quick Titles and Figure descriptions can be added to Spectra.  

• Icon to save Spectra to file 

• Subtract back ground/Restore back ground icons 

• Icon for adjusting x,y scales 

Capture Application 
 These features are in addition to the Spectrum Display Window. 
 The following additions are included: 

• Direct transfer of parameters between the MRS table and the ESCA control Panel 
o Test Region button transfers the parameters of the marked region of the MRS 

table to the ECP and starts the data capture. 
o Update Region transfers the parameters in the ECP to the marked Region in the 

MRS table 
o A blank Region in the MRS table can be filled.  Automatic assignment to 

appropriate MRS table functions is performed. 

• Elapse time estimate provided for MRS table. 
o Scan time is provided for each region 
o Total time for all regions is provided 
o Time to run from marked region to end of MRS table is provided. 
o During Capture the total time for the current region to the end of the MRS Table 

is provided. 

• MRS Table improvements 
o Each region Time/Step may be programmed in 25 millisecond steps. 
o In UnScanned mode, Detector Width and Channel Width are displayed. 

 

• ESCA Control Panel (ECP) Improvements 
o When ECP is closed the state of the parameter set is stored as the “Last Used”. 
o At any time you can store the current state of the parameter set as “Default”. 
o You can set the ECP to open using the “Default” or “Last Used” parameters. 
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o A Count Rate mode is added using an exponential decay with time.  This 
provides monitoring the effects of changes in charge compensation, crystal 
adjustments and spectrometer adjustments with and adjustable time filter. 

o “Quick Shift” Binding Energy change.  This control behaves like the “brush” 
mode on IPod displays.  The control will move the CBE as much as half a window 
with in either direction. 

• Toolbar icons for quick opening of “Analysis”, “ESCA Control Panel”, “Big Display” and 
“Export” of spectra. 

• Setup ESCA (Found in the Settings menu) 
o Configuration table – Added buttons to allow saving and loading the 

configuration table.   Use to back up calibration information. 
o Added a default peak fit to locate peaks in Detector Width Calibration 

• Add additional diagnostics to detect connection problems with detector. 

• Improved reliability of Depth Profile setup, running and ion gun control. 

• Region Name cell in MRS table is used in Quick Titles for auto assigning names.   

 
 
Analysis Program 
 These features work with the new features of the Spectrum Display Window 

• Fast Report (FR), a powerful report generation program, has been imbedded for hard 
copy output of analysis information. 

o A set of templates are included to provide standard print configurations. 
o The full Fast Report Designer is imbedded to allow modification and storage of 

templates. 
o Fast Report (FR) provides extensive tools for adding spectra and data to 

predefined reports. 
o Report Review provides options for a wide range of export of assembled data. 
o Tables can be automatically added to Fast Report 
o Column Titles, Placement, Visibility, Format and Font are selectable in Fast 

Report. 

• Editing of Project, Experiment and Region names. 

• Delete for Projects, Experiments and Regions. 
 

• Print Tool Bar 
o Select Template 
o Add (one) Region to Fast Report (+Regn to FR) 
o Add all Regions to Report (+ All Regn to FR) 
o Empty Fast Report  (Empty FR) 
o Review the assembled report (Review Report) 
o Print  out assembled report (Print Now) 
o Design or modify a template (Design Template) 
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• Table Functions 
o Export Tables to EXCEL 
o Copy full table Clipboard  
o Copy single row or column to Clipboard 
o Launch Table with cells unprotected  

DP Viewer 
 DP Viewer can be launched directly from the Analysis Application tool bar. 

• Tool Bar 
o Add Control of line color 
o Export all cycles of one Region as EMF files.  Each EMF file contains one 

spectrum. 
o Zoom Control 
o Support for Predefined Chart properties after export to EXCEL 

 
SEE - OVERVIEW OF NEW FEATURES after next section for examples of 
these features. 
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Recommended system configuration. 
 

1. Pentium IV or higher, 256K Ram, 1Ghz  
2. USB 2.0  
3. Windows XP operating system with service pack 2 
4. Microsoft Office 97 or higher (Word, Excel and Power Point). 
5. 19” Flat panel Display. 
6. CD R/W  
7. Color Printer 

Windows 2000 operating system MUST HAVE SERVICE PACK 4 INSTALLED to upgrade 
to ESCA Hawk.   The export to Excel requires various security configuration changes in Excel to 
allow the macro program to operate.  If problems occur exporting to Excel see notes at end of 
install section or contact Service Physics for help.   

Preparation of system for upgrade. 

1. Backup calibration file.  Older ESCA software does not have a calibration export utility.  
The ESCA Hawk CD has included a program that will create a backup calibration file.  
The utility is in the Folder, “Hawk Support” > “ESCA Calibration Config” .  Copy the 
file, “XpsRegReadSetup.msi” to the existing ESCA Program folder where the old ESCA 
program resides.  Double click the file to start the utility.  Follow the directions to create 
a backup of the calibration configuration.  We suggest you use a name such as ESCA 
Cal 080521.  This provides the date code year 08, month 05, day 21.  ESCA 25 and 
ESCA Hawk have this utility built in.  You will be able to load the calibration file after 
ESCA Hawk is installed.  A history of your calibrations can be created from the backup 
files saved in the Configuration subfolder of you ESCA Hawk program folder.  See page 
22 in this manual. 
 

2. Uninstall existing ESCA program.  Do not uninstall MDAC, National Instruments 
Software, ACCESSRT, CH Products or Motion Planner.  See section below if you are 
updating your operating system. 
 

3. Updating Operating systems.  If updating system from NT the IEEE488 National 
Instruments card will not work.  A new PCI GPIB card needs to be purchased.  The 
IEEE488 version 2.22 (or higher) driver should be used.  If updating from Win 2000 to 
XP it is best to reformat the Hard Drive and install a new copy of windows XP with 
service pack 2.  The PCI GPIB card used on 2000 will work but the Version 2.22 (or 
higher) driver must be used and not the old driver that may be on the National 
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Instruments CD.  IEEE 488.2 V2.24 is included on the ESCA Hawk CD.  Updating 
requires additional memory and will run much better with at least 1 GHZ processors.   
 

4. ESCA 2000 V1.02.0x releases do not have the backup utility discussed in paragraph 1.  It 
is very important to follow the backup instruction if your are changing operating 
systems or using a new computer.  If you are making no changes to the computer 
operating system the old configuration should not be lost.  It is still advised that you 
follow step 1 in case of computer problems. 
 

5. There have been problems uninstalling ESCA2000 V1.02.0x.  A utility is included on the 
CD called Uninstall Cleanup.  This is found in the Uninstall Utilities folder.  This 
program cleans up a number of problems with the registry and removes some 
components that are not removed by uninstall.  This program should be used to clean up 
any installation that has had previous problems including ESCA Hawk V1.01.   
Uninstall Cleanup provides a report about the cleanup.  The desired result is that each of 
the components is not found.  If found it uninstalls them and deletes the file from the 
system 32 folder.  Please have the utility make a log file if any cleanup is needed.  
Please e-mail the log file to us. 

Install upgrade. 

1. If installing ESCA Hawk on a new computer or on a computer with newly upgraded 
operating system then do the pre-install in step 2 below.  If no change to the operating 
system then jump to step 3 below. 

2. Pre-install support components on new computers and computers with updated operating 
systems.  See table 1 below for components that need to be installed. 

3. Install the new ESCA Hawk program.  Put the new CD in the disk drive.  Find the ESCA 
Hawk folder and run the Setup program.  Accept all default options.  Accept keeping 
newer components that may be on the hard drive. 

4. Copy the Calibration Configuration file, saved in step 1 of the “Preparation of 
system for upgrade” section above, to the Calibration folder in the ESCA Hawk 
directory. 

5. If this is a new installation you will need to get a Serial Number form Service Physics by 
e-mailing either bob@sphysics.com or barb@sphysics.com. 

6. Open the Capture program.  Select the settings menu.  Select Setup ESCA.  Open the 
Configuration Tab and select the Load from File button.  Navigate to the Calibration 
folder and load your backup calibration parameters. 

mailto:bob@sphysics.com
mailto:barb@sphysics.com
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TABLE 1 – SUPPORT COMPONENTS FOR ESCA HAWK. 
VERSION DATA BASE MOTION  JOY STICK 
ESCA HAWK A ACCESSRT* NONE NONE 
ESCA HAWK B, BU ACCESSRT* NONE NONE 
ESCA HAWK G, GU ACCESSRT* NI 488.2 V2.24 NONE 
ESCA HAWK E, EU ACCESSRT* 6K4 MOTION 

PLANNER 
CH PRODUCTS 

 
 
 
NOTE: USB VERSIONS WILL AUTOMATICLY INSTALL THE USB DRIVER.  LEAVE 
THE USB CABLE DISCONNECTED DURING THE INSTALLATION OF THE ESCA 
HAWK PROGRAM.  AFTER THE PROGRAM IS INSTALLED THEN CONNECT THE USB 
CABLE.  THE WIZARD WILL ASK IF YOU WISH TO LET WINDOWS FIND THE 
DRIVER.  BE SURE IT IS NOT ASKING TO USE THE INTERNET.  IT SHOULD LOOK ON 
THE CD FOR THE DRIVER.  WINDOWS WILL AUTOMATICLY FIND THE DRIVER ON 
THE CD AND INSTALL.  IF THE USB DRIVER IS ALREADY INSTALLED WINDOWS 
WILL SKIP THIS STEP.  
 
*ACCESSRT IS FOUND IN THE SUPPORT FOLDER ON THE ESCA HAWK CD. 
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OVERVIEW OF NEW FEATURES 
New MRS Table design 

 

• Display Detector Width for UnScanned Function 
• Display Channel Width of the Detector for UnScanned Function 
• Time/Step (Dwell Time variable) may be input in 25 millisecond steps 
• Actual elapsed time for scan.  This is longer than the time spent capturing data 

due to computation overhead.  Longer Dwell times reduce percent overhead. 
• Elapse time for complete MRS – “Full Run Time” 
• Elapse time from current active row to end of MRS – “Row to End Tm” 
• “Row to End Tm” tracks the progress of a running MRS table. 
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Test Region 

 

• Selecting “Test Region”, in controls above the MRS table, transfers data from active row 
of the MRS table (Yellow Highlight button) to the ESCA Control Panel.  If panel is not 
open it will open, down load parameters and start data collection. 
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Update Region 

 

• Changes to ESCA Control Panel are uploaded to MRS table. 
• Resolution was changed from 2 to 1, Number of scans from 1 to 2 and the Scan Time was 

updated. 
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Update Region used to build MRS table 

 

Add a blank line to MRS table. 

 

 

 

Selecting Update Region creates the correct function and enters the parameters from the ESCA 
Control Panel. 

 

 

 

 



12 
 

Time average with exponential decay. 

 

 

 

 

 

 

Quick 
Shift 

Release slider 
starts shift.  

New CBE 
displayed 

Ev  shift 
displayed 

5 sec  elapse 



 

 

ESCA Control Panel Initialization 

 

• Set Current As Default – Stores the current parameter set. 
• Each time the ECP is closed the current parameter set is saved as “Last Used” 
• The selection buttons allow the user to chose which parameter set will be used the next 

time the ECP is opened. 
• The parameter set is the eight parameters in the black box starting with the CBE and ending 

with the Tm/Step. 

CBE/LBE and Avg T/Cap T Buttons 

The buttons above the start BE box is fixed to CBE for UnScanned spectra.  You can select CBE 
or LBE for scanned spectra. 

The button over the Time box can be switched from Cap T (Capture Time) to Avg T ( Averaging 
Time) in the Unscanned Mode.  It displays the elapse time for a scanned spectrum. 
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The Project, Experiment and Region information can be edited using the MDB Editor.  The Editor 
can also be used to delete at any level of the project tree.  The Data Base structure is very detailed 
and includes reduced data sets that have been stored.  Please keep in mind that deleting an 
Experiment or Project deletes all information stored for the project or experiment. 
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Spectrum Display Window (Graphic Viewer) 
 
   Create Spectra Appearance Preferences using the Chart Preferences Dialog 
 

 
 

Chart Preferences Dialog 

 
There are three targets window types; workspace, print and copy to clipboard.  You can 
create a preference configuration using the “Create New…” button.  You can edit any 
configuration using the “Edit Chart Preference Editor” button.  One configuration must be 
checked for each target. 

 

Chart Preference Dialog 

Default preferences configurations for: 
DftWkSp = Spectrum Workspace Display Window 
DftPrint = Spectrum sent to print and export. 
DftChartCopy = Spectrum put on Clipboard 
 

Edit opens Chart 
Preferences Editor 

Target window types 
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OPEN Chart Preferences Editor 
 

 
Simple changes of spectrum are selected and  reviewed on Chart page. 

  

 
Change grid type and visibility.   Change the background color.  Change text label for x 
and y axes.  
Note:  The line color is changed using the color wheel icon on Graphic Viewer Toolbar.  
Line colors are unique to the spectrum not the window preference. 

 
NOTE:  WE HAVE INCLUDED THE NEXT EXERCISE TO INTRODUCE THE ADVANCED 
EDITOR. 
 
PLEASE DO THE FOLLOWING EXERCISE TO SET UP YOUR NEW SOFTWARE!  
 

No check removes grid  

Open color pallet 
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Exercise 1.  ADJUSTING THE CLEAR SPACE ABOVE THE HIGHEST PEAK. 
Spectrum with highest peak touching top of window. 
 

 
 

Advanced Editor 

 
The Axis tab is selected. 
To change the clear space at top of spectrum select: 
Advanced Editor >Axis >Position.  Change the value in the “Start %” entry box. 
 
When the Advanced Editor is used the settings will be saved when “Done” is selected on the Chart 
Preferences Dialog.  This setting will be used for the target window (Workspace, Print or 
Clipboard) selected.  IF YOU WANT THE SETTING TO MATCH IN ALL TARGET 
WINDOWS YOU WILL NEED TO EDIT EACH CONFIGURATION. 

Use “Start%” to control clear 
space at top of spectrum 

Axis 
Position 

Start% = 20 
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Quick Titles and Figure descriptions 
 

 
Quick Title Entry for Spectrum dialog 

 

 
Result of using Apply All Button 

 
Region name is established one of 4 ways. 

• By default when spectrum is collected.  It is the line number in the MRS table. 
• By entering a name in the region cell of the MRS table.  See Below. 
• From the Region Name entered in the Capture, Depth Profile table. 
• By editing the Region Name in the Scan Table. 
• The Tools for Smooth, Differentiate, Integrate, Add and Subtract provide entry of Region 

names for the derived spectra. 

Open Quick 
Title Dialog 

Region name will 
be appended at 
beginning of Title 

Region name added to title 



 

20 
 

Examples of Region Name entry 
 

 
Region name entered in MRS table in Capture Application is used in Analysis Scan Table 

 
Depth profile Region Name 

 

 
 
 

Enter Region Name here in MRS table 

Name displayed here in Analysis! 

Enter Region Name as peak 
identification.  Links to Auto 
Scofield lookup in DP Viewer. 
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Edit Region Name in Scan List 
 
  

 
Region can be renamed in scan table. 

 

 
Tools auto create new Region Names. 

 

Click in cell and then retype Scan Name. 
Result is saved by tabbing out of cell. 

Smoothing tool 

Setup for new 
Region Name 

New region 
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Region as only title. 

 

 
Modify Header and Footer fonts 

 
Select: Chart Preferences > Chart Preference Editor > Titles > Fonts > Size and Color. 

Clear text boxes to remove title and footer text.  Leave Auto 
Inc checked.  Region is automatically used as header. 
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Region header with Font, size and color changed. 

 
See section on Fast Reports  (Page 23 -  32) for examples of using 
the Graphic Display Header and Footer information to enhance 
the Fast Reports.  
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Icon to save spectrum to File 

 
 

Notice the older font, size and color are in use.  The graph background was set to white and 
the grids are present.  To bring them up to date we will use the Chart Preference Dialog to 
edit the Default Chart Copy preferences.  After preferences are set they will remain even if 
the Application is closed.  They are fixed until you change them.  If preferences are entered 
in the Analysis Program they will be installed in the Capture Program the next time it is 
opened. 

 
 
 
 
 
 

Graphic to 
clipboard or file. 
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Customize Background Color for Power Point Presentations 
 

 
Preferences for clipboard are used for Export.  Clipboard preferences set for pasting into 
Power Point. 

 

 
 

Clipboard was pasted into this instruction document in the above document.     Now each 
Region selected will have the same format.   Region names will be automatically entered as 
the title. 

Demonstrating line color control and auto assignment of Region name as title. 
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Background removed/Background restored. 
 

 

 
Background remove and restore icons. 
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Axis Adjusting Tool 
 

 

 
 
If the Graphic Viewer Window is small there will not be enough room to place the lettering in the 
auto fine format.  Auto Fine and Auto Coarse have different spacing models but in a small window 
they default back to the Graphic Viewer model.  The Fixed Model lets the user set the increment 
between labels.  These fixed values will be used regardless of the Maximum and Minimum of the 
data.   The fixed scale model will produce “bad behavior” during data collection. 

Scale 
Adjustments 

Auto Fine Settings 
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Capture Application 
 
Settings Menu 
 

 
 

 
“Save to File” and “Load from File” 

 
The calibration information in the Configuration Tables is extracted to a XML file to 
provide backup of the instrument calibration.  The “Load from File” button loads the 
backup data into the operating system registry to restore you system calibration.  Older 
software did not have this capability. 

 
The CD provided has a folder labeled System Calibration Utility.  This program should be 
loaded on older installations and run to provide the backup file.  After the upgrade the 
“Load from File” utility can be used if the calibration information becomes lost.  This must 
be done if a new operating system is used in for the upgrade.  

 
The “Save to File” button should be use to save any changes after calibration or service to 
the instrument.  The file should be saved to provide a calibration history. 

Set up ESCA Utility 

NEW - Save and load 
calibration configuration table. 

Configuration tab 
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Hawk Analysis Application 
 
Fast Report 
 

Fast Report is a robust, imbedded program that connects the Graphics Viewer, Data Spread 
Sheet and Capture Parameter list to a predefined template.  The assembled information on 
the template can then be printed, stored or exported as HTML, EXCEL, RTF or PTF files.  
The template designer provides a flexible way to customize your output.  Predefined text 
can be incorporated in the template to provide standard reports with the spectra and graphs 
automatically included. 

 
We have included 7 standard templates to provide convenient printing and exporting.  To 
print out a spectrum you only need to select “Print Now” and the active spectrum will print.  
To print a spectrum with the composition table choose the appropriate template and select 
“Print Now”.  If you have a large number of spectra in the region table you select “+ All 
Regn to FR” (add all regions to Fast Report) and then select Print Now. 

 
You can always preview the print out before it is printed or exported.  It is not possible to 
edit the information once it is entered into Fast Report.  It is important to have the spectrum 
and tables the way you want them before adding to fast reports.   

 
One spectrum, with or without a table, can be added to Fast Report at a time by selecting 
“+ Regn to FR”.   

 
The report template can be Empted (Cleared) at any time. 

 
The following examples demonstrate the flexibility of this printing system. 
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Selecting a Template 
 

 
 

Dialog used to select template.  Templates are available that show Spectra with header, 
collection parameter list, and data tables.  The header provides a space for Laboratory name 
and logo.  Custom templates can be created, stored and retrieved using the Browse button. 
 
The following pages display examples or printing with the seven templates. 

 Select Template 
to open Dialog 

Active Template 
is highlighted. 

Choose template and 
select “Save and Close” 
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Company information and logo 
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 CAUTION:  THE COMPOSITION TABLE COMBINES DATA FROM ALL SPECTRA.  THIS 
IS TO ALLOW MIXING OF HIGH SENSITIVITY SCANS TAKEN AT RES 4 WITH 
SURVEYS TAKEM AT RES 4.  IF TWO SURVEYS ARE IN THE SCAN TABLE BE SURE 
ONLY ONE TABLE HAS “Y” CHARACTERS IN THE INCLUDE COLUMN.  YOU MUST 
ALSO BE SURE YOU MATCH THE SPECTRA ADDED TO FAST REPORT WITH DATA 
TABLE INCLUDED IN FAST REPORT.  THERE IS ONLY ONE COMPOSITION TABLE 
AND THE “+REGN TO FR” BUTTON WILL ADD IT TO ANY ONE OF THE SURVEY 
SPECTRA IN THE TABLE.   
 
PEAK FIT TABLES ARE MATCHED WITH THE SPECTRA USED TO COMPUTE THE FITS.  
The above caution does not apply to the peak fit tables.  This can be seen in the example above. 
 
The “Quick Title” tool button allows information to be added to the fixed Templates.  See pages 
12-16 for details on setting up Quick Titles.   
 
Special print-to-file options are provided in “Review Report” utility.  The graphic can be printed, 
sent to the clipboard, or exported in a number of formats. 
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Table Functions Tool Bar 
 

 
 
 
 

The clip board icon picks up the table.  In this example the table was pasted  into this word 
document.   The table was then edited in word to eliminate the sensitivity column.  Words 
table editing tools provide column, row and cell formatting and editing.  

  
XPS Line Adj'ed Be Norm Area Atom % 

O 1s 530.062 366.010 53.830 
C 1s 284.556 154.538 22.728 
Zr 3d 181.965 159.395 23.442 

    
        

Clip board 
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The tables can be exported to EXCEL or the embedded spreadsheet can be used for 
copy and paste operations.  The “copy selection” icon can be used to pick up a single 
row or column.  You can select multiple rows or columns if they are continuous 
without skipping any rows or columns.  
 

 
 
The “Launch Spreadsheet” icon opens the VCI Formula One designer.  This provides 
access to the embedded spreadsheet.   A standard set of design tools are available.  The 
redesigned spreadsheet can not be used to change the spreadsheet properties of the 
ANALYSIS Hawk application.  The redesigned spreadsheet can be printed or pasted to 
other programs. 
 

The entire table can be 
exported to EXCEL. 

Single Row or Column 
data can be selected and 
copied to the clip board 

Open the embedded 
spreadsheet 

All tools of spreadsheet 
available 
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The following example displays some of the available tools. 
 

 
Use the Format > Column > AutoFit Selection to expose all the columns of the spreadsheet. 

 

 
 

  
The Insert > Column command can be used to enter an empty column. 

Insert Column 
Empty Column Inserted 
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The Edit > Copy command can be used to copy a complete column and then Edit > Paste 
Special to fill the empty column.  Use the Values mode to insure the numbers are copied 
and not the formulas. 

 
The rearranged table may be printed or copied to the clipboard.  The format tool provides 
hide column or hide row functions. 

 
The VCI  Formula One Designer has been opened with cell protection turned off.  This  
allows the editing of both the cell values and formulas. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use copy to pick up 
Atom % column 

Paste special with 
“values” checked to 
fill empty column. 
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DP Viewer 
 
DP Viewer provides an alternate depth profile tool.  This tool is in development.  Any suggestions 
for improvement are welcome. 
 
In the first window you may browse to an alternate Scofield table.  It is recommended that you use 
the Programdb.mdb that is in the C:\Program Files\Esca 2000 folder.  The Scofield table contained 
in the Programdb.mdb can be loaded by selecting [Load Table] when the path is showing in the 
path window. 
 
 
 
After the Scofield is loaded the DP Viewer will open.  No default depth profile is loaded.  Go to 
the Folder Icon to open a database.  You may navigate your network, hard drive or removable 
media to locate the folder that contains the database of interest.  When the database is selected the 
project/experiment tree for the database will be displayed in the right pane.  Find the Raw data or 
previous Analysis for the depth profile of interest.  Select open to load the depth profile data into 
the DP Viewer. 
 

 
 
 
 
 
 
 
 

Click Load Table 

Be sure path is to ESCA 07 
\programdb.mdb 

Check the “don’t show” 
check box 
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DP Viewer with data loaded.  There are no default baselines assigned.  Select the spectral region to 
view.  Cycle 1 will be displayed by default. 
 

 
 
Select a measurement mode.  The Zoom tool is turned off when you enter a measurement mode.  
The Area mode is shown in this example.   

Open dialog to 
find Database 

Raw data for DP 

Previous Analysis 

Load data 

Select Region 
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Set the end point average.   In the example, 3 points to each side of the selected point will be 
averaged, for a total of 7 points. 
 
Choose linear or Shirley base line. 
 
To draw a base line click near the spectrum.  The end points will jump to the point you click.  
There is no need to “sneak up” to the current end point, activate it and then drag.  When you like 
the starting point then drag.  Now click [Next >] to measure the area. 
 
If this is the first spectrum, for the selected region, then [Is Fit Template] check box will be 
checked by default.  This means the binding energy of the two baseline endpoints can be used to 
define the base line for the rest of the cycles.  Use the [Propagate Reg] button to propagate the area 
measurement to all cycles of the selected region.  
 
You can move to a different cycle, draw a baseline and select next to make an area measurement.  
Then check the [Is Fit Template] check box.  Now this cycle will become the Template.  The 
original cycle will be automatically unchecked.  The new template can be propagated to all cycles. 
 
A cycle can be selected and its endpoints modified.  When next is selected the new endpoints will 
be used to measure the area for this cycle only.  Not all cycles need to have the same endpoints. 
 

 
 
After the [Next >] button is clicked the area is measured and presented in the table. 
 

Area measurement mode 

End point average 

Cycle control Propagate all regions 
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The cycle and be changed using the up/down arrows or the mouse wheel when the cycle control is 
active. 
 

 
 
Select a new region using the [Region Control] 
 

Data presentation 
for current cycle 

Blue indicates the cycle control 
is active.  The mouse wheel 
provides a very convent way to 
review cycles 

Move to cycle marked as 
Fit Template. 
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To view all cycles at one time select the [Group Region Tab] 
 

 
 
 
Double click the 3D display to bring up the Display Control.  May options are available. 
 

Region Control 

Group Region Tab 
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The Atom percent is computed and displayed based on the regions/cycles measured.  It is only 
computed for the cycle displayed. 
 

 
 

Calculate Atom% 

Preview depth profile 

Excel Report 
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Preview of Depth Profile.  This preview can be printed.  The chart editor provides font control, 
background color control and much more. 
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Exporting Depth Profile to EXCEL 
 

To export the profile to EXCEL select the “Make a Report” button in the DP Viewer 
toolbar.  The “Chart Options Dialog will open.  The X axis scale type can be selected as 
Depth, Etch Time or Cycle.  If Depth is selected enter the Etch rate.  You may also enter a 
title for the Depth Chart.  Select Continue. 

 

 
 
The Scofield Table locator will be presented if the “don’t show” check box is unchecked.  
Select the [Load Table] button. 
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After the export, the EXCEL application may be minimized but the Indicator will be 
present in the Windows Status bar at the bottom of the display.  If you view the DP Viewer 
window you will find the following Report Log.  It may contain the following Error in the 
5 line.  This is a result of the security setting in EXCEL for using VBA programming.  This 
is not a fatal error.  The Export will be complete.  Some special programming features that 
are not currently activated will not be available.  The Error can be eliminated by changing 
the security setting as described in the Software Installation section of this Instruction. 

 

 
 

 
 

Security setting for EXCEL 2007 used to avoid programming error. 
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 Report with Security setting changed to “Trust” VBA programming. 
 
 

After the Excel application is loaded with all the depth profile data the Excel Tab will stop 
blinking in the Windows Application Tray.  Select the tab to display the tables. 

 

 

EXCEL Tab 
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The first tab will display the depth profile.   Atomic percent data tables are summarized in 
the Summary table.  The Composition Table tab displays full data for all cycles. 

 

 
 

Tabs to select 
presentations 
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 Summary tables in EXCEL 
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Cycle by Cycle Composition Tables 
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Depth vs Area Chart. 
 

The data exported to EXCEL allows the Analyst flexibility in organizing, formatting and 
presenting the data. 
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Other DP Viewer Functions 
 

Auto-lookup of Scofield crossection.  If the label given each region uses the standard XPS 
transition line format, such as Au 4f, then the Auto-lookup feature will find the Scofield 
crossection and compute the normalized area.   

 

 
If the label is not found in the Scofield table then a dialog will be displayed.  This dialog 
may result from errors in entering the label. 

 

 
In the Capture Application the XPS Line designations can be used to label the Region 
Names.  This provides the correct information to the Auto-Lookup feature in the DP 
Viewer Application. 
 

XPS line imported 
from region label 

Incomplete XPS 
line  designation. 

Correction to XPS 
line designation. 
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Correct entry of XPS Line designations in Depth Profile Dialog will facilitate the auto 
assignment of Scofield Crossection information. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Use XPS line designators as 
Region Names to enable the 
Auto-Lookup feature in DP 
Viewer 
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 Line Color Control and Export all Cycles of one Region 
 
 

 
 
 

Line color control Export all cycles of one Region 
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Configuring EXCEL Security 
 
Excel allows macro programs to be used to automate the behavior of the Excel application.  DP 
Viewer uses this feature to automate the setup of charts and tables in Excel.  There has been 
increasing levels of security added to Excel releases.  The security help to keep  dangerious 
programs from being embedded on computers tied to the internet.  Excel XP 2003 and Excel XP 
2007 have this protection built in.  The protection can be modified so DP Viewer will still operate.  
The following describes how to change the protection settings. 
 
EXCEL XP 2002 
 
Open EXCEL and make following settings. 
 

 
 
OPEN THE SECURITY DIALOG  
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SET SECURITY LEVEL 
 

 
 
SET TRUST SETTING TO ALLOW ACCESS TO VISUAL BASIC 
PROJECTS. 
 
 
 
 
 
 
 
 
 
EXCEL XP 2007 
 
Excel 2007 must be installed with the developer options.  With the Developer options selected 
select the Macro Security dialog.  Make settings as shown. 
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If macros are disabled specify notification is required.  Select to trust 
access to VBA project object model. 
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